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PLEASE READ CAREFULLY. BY USING THIS PRODUCT, YOU ARE CONSENTING TO BE
BOUND BY THIS AGREEMENT.

The AGTEK software package, on CD or in electronic form, together with associated
documentation, is protected under copyright. The buyer may make copies for the buyer’s
internal use only. The buyer agrees not to reverse engineer or otherwise seek to discover
the source code, or to modify or create derivative works from this software.

AGTEK grants to the buyer a non-exclusive, single license to load and use the AGTEK
software on one or more computers operated by the buyer, provided that use by the
buyer shall not be on more than one computer at a time. The buyer agree not to rent,
loan or otherwise temporarily transfer this software for use on computers not operated by
the buyer.

Access key. The AGTEK software is enabled by means of an access key that must be
present on the computer when the software is running. The access key may be a key
code checked-out from the Internet or a physical device that plugs into a computer port.

AGTEK software includes cryptography that is not user-accessible, specifically designed
to allow execution of copy-protected software. Accordingly, this software is controlled
under ECCN EAR99 of the Export Administration Regulations (NLR, no export license
required). The buyer agrees to comply with all applicable regulations and prohibitions with
regard to export or re-export to sanctioned countries or individuals.

Limitations of warranty and liability. AGTEK software is licensed “as is” and with all
faults. AGTEK Development Company, Inc. and its Representatives make no warranties,
either expressed or implied, with respect to AGTEK software, its quality, performance,
merchantability, or fitness for any particular use. In no event will AGTEK Development
Company, Inc. or its Representatives be liable for direct, indirect, incidental or consequen-
tial damages resulting from any defect in AGTEK software, even if AGTEK Development
Company, Inc. has been advised of the possibilities of such damages.

Copyright® 2011 AGTEK Development Company, Inc.

Windows XP® , Windows Vista® and Windows® 7 are registered trademarks of
Microsoft Corp. Google Earth™ is a trademark of Google. AutoCAD®, CAIiCE™, DWG™,
DXF™ are trademarks of Autodesk, Inc. GEOPAK, MicroStation, GPK and DGN are trade-
marks of Bentley Systems, Inc, Leica™
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SmartDirt Installation

A E

EARTHWORK

v Welcome to SmartDirt
Instructions for Installing the AGTEK SmartDirt app on your Android phone or tablet.

1. To install SmartDirt on your Android phone 2. Tap Downloads.
or tablet, visit our website at www.agtek.com.

On the Home Page, tap the Menu bar and tap

Support.

.“-"‘\.

B AUE T9% W 2:22 PM

() www.agtek.com/support.hti  [1]

4 2]

DOWNLDADS TRAINING VIDEOS
i

NEWSLETTERS EMAIL SUPPORT

= = 3

\ T——
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SmartDirt Installation

3. Scroll down to SmartDirt. Tap SmartDirt 4. Tap Download to start the download
and enter your technical support login and process.
password, You may need to get this informa-
tion from your support contact.

= o
® 7= T78%

> (> wwwagtek.com/programPa [1] 3

see versior

notes AG

1.3.2 10/24/2017 Android 8 _
compatibili SmartDirt

4 The latest version of SmartDirt is listed
11 4212017 Adds track below. Click on the download button or

segmentiny filename to start the download.
statistics

215.2 9n9/2011 First 64 bit Program Download (4/10/2018)

version, se
the version
notes

Version Filename Size

2.2 Na t- 5.8
mb

22 4/10/2018 Adds
New Compactio
import/exg
see versior

notes

11 21212018 Adds
Compactio
import/exg

1.6.3 10/24/2017 Android 8 Manuals (requires Adobe Acrobat)
compatibili
rev: 12/28/2012

1.1.1 10/24/2017 Android 8

compatibili

A111/79N14% Wah ann _ |

= o <

| T OSSR

L
Ll
gdh
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SmartDirt Installation
5. When the download is complete, tap Open 6. Tap Install to begin the installation.
at the bottom of the screen. Depending on
your browser settings, you may need to swipe
down from the top to view the download.

e k“-\‘-.

B TS 0 75% @ 2:36 PM R TU= 0 75% 8 2:37 PM

(O www.agtek.com/Programpa  [1] 3

| this application?

AG

SmartDirt

access precise location (GPS and

network-based)
The latest version of SmartDirt is listed

below. Click on the download button or -

& Modify or delete SD card contents.
fllename to start the download.

read the contents of your SD card

Program Download (4/10/2018)
Version Filename Size

2.2 Na t- 5.8
mb

Manuals (requires Adobe Acrobat)

rev: 12/28/2012

SmartDirt-2.2.apk downloaded OPEN CANEEL. IHEIaiL
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SmartDirt Installation

7. When the installation is complete, tap
Done to exit or Open to start SmartDirt.

B THEa75% 8 2:37 PM

App installed.

DONE OPEN

= 3 <

9. To launch SmartDirt for future sessions,

tap the SmartDirt icon in your Apps folder.
You may move the icon to your main screen.

SmartPlan SmartDirt

8. Enter you Login and Password. Check

Remember Password and tap Login.

Q 2 =0 75%H 2:39 PM

Login: johnsmith@agtek.com

Remember password

Login Cancel

@v.
1020340567189 0
qiwilejrjtiyjujijolpB
alsfidiflaglhlilkil
T lzixjc]vib]n|mpgds

1#1 , English (US) . Done

= [J N2

| TR
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SmartDirt Geo-Referencing Files

Earthwork 4D Geo-Referencing Files

Before you can use your earthwork takeoff in the field with SmartDirt, you must first
enter two benchmarks with approximate latitude and longitude information. There are

a couple ways to enter the benchmarks. If the takeoff was done from a PDF file, the
benchmarks would need to be entered using Google Earth to establish the latitude and
longitude. If the takeoff was done from a CAD file that is in state plane coordinates, you
may use the Map Projection Settings utility.

Enter Benchmarks using Google Earth

If the takeoff was completed using PDF plan sheets, we may use Google Earth to estab-
lish the benchmarks with approximated latitude and longitude.

1. Locate your job site on Google Earth.

= Google Earth r= Bl =)

Fle Edit View Tools Add Help

¥ Search

[1E9 Temporary Places

EI + v

¥ Layers Farth Gallery )
4 @ primary Database

Lindbergh-Ave:

& CI €% Weather

2. ldentify some existing features that can be found on the plan sheets. Existing curb
corners, catch basins, or street intersections are good examples.
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SmartDirt Geo-Referencing Files

3. Open the job file in Earthwork 4D.

4. Import the plan sheet containing the existing features located on Google Earth.

Y A ek 0 - 5% W] [GTAGTER Du TRy Sl (5 5
Fin Edl Vi Coopley Lhbty Opfom Window Hep Guide

Boweet | Lo ok ooy 5 s (B viwe BF eoien 9 pvew (W vousecpan M vonsen D) Pevien

O e # SuTae [Desgn Layer | Data Lines

QUTEs A GYLOMPREFEEAN &

e e |

5. Locate the two common features found on Google Earth.

Y AT Earth e D - (0% Mg [€]AGTER DRI T Sr Ky St £ £50{ B
Ble f#1 View Qoogley U8By Cstiom Mindew Hep o Guide
Boweot | Lo ok ooy 5 owaee [ viwe BF eoien 89 apwew (W vouseepan M vonsen D) Pevien

Qi e SuTes |Desgn Layar |Data Lines

@r

QE L A LYLOMPREFDERE &

ik [ tare s var i v

6. Minimize Earthwork 4D and return to Google Earth.
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SmartDirt Geo-Referencing Files

7. In Google Earth, select the Show Ruler icon, or select the Tools menu and select
Ruler.

8. Draw a line connecting the two points. Click the Save button.

= GoogleEarth (== B )
File Edit View Tools Add Help
¥ Search [= IEEEGEE]

(&)

Ruler

[tne [path | pro |

Measure the distance between two points on the ground

Vep Length: 425,47 [Feet =
Ground Length 2548
Heading: 174,55 egrees

] Mouse Navigation

4 S My Plac
[HED Sightseeing Tou
1

@)

B empo

D + ¥

¥ Layers Earth Gallery 5
< @ 2 primary Database
i Voyager

-Lindbergh-Ave—

¢ :
Google Earth

- [Tl Gallery * Tour Guide @ | 2002 mag 2 401t eyealt 1196) e

9. Keep the name Line Measure and click OK.

10. Right click on Line Measure under Temporary Places and select Save Place As.

= GoogleEarth (B8 e
File Edit View Tools Add Help

¥ Search

| Search

ections History

¥ Places
< WS MyPlaces
e s

I
(V177 Untitled Polyg
4+ I & Temporary Places

171 Line Measure

Q Revert
Qlm ever
v Layers Save to My Places

< @ & primery Data Save Place As.
[T Vovager

Ermail.
Snapshot View

Show Elevation Profile

Properties

GoogleEarth
=

More
Lindbergh-Ave.

% Tour Guide B 2002 T 0 A0

11. Save the file to the same file folder containing the Earthwork 4D job file.
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SmartDirt Geo-Referencing Files

12. In Earthwork 4D, right click and select Import File.
13. Select the Line Measure.KMZ file and click Import.

P LTER Earthvwoek AT - B Mode] [CTLAGTER Duish Tuoarih irmany SroaePlan 105 esaf =
Eir B0 View Dipley WNEly Detiom Sindow Dep Guide
4o R Ein [ ate B vawn B mamien 88 v (W vousecpd [

Surfaie | Desgn - LaWT | Benchmanks

14. The Benchmarks will be inserted, however they will not be in the correct location.

15. Change the layer to Benchmarks.

16. Select one of the benchmarks. Position the tip of the arrow on the corresponding
location on the plan sheet and press the F7 key to move the benchmark to the new

location.

0T ity St T e

I LSTEK Earthwoes D - e Mgd] (<7407
Bie Eft View Chosley WNEy Dstiom

£ o gk

Y i Surface | Desgn

Wertn. 338087 taie sz Dot 2 n rt v

13. Repeat this process for the second benchmark.

14. The ADF file may now be exported.
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SmartDirt Geo-Referencing Files

Enter Benchmarks using Map Projection Settings

If the takeoff was completed using CAD file that is in state plane coordinates, we may
use the Map Projection Settings utility to establish the benchmarks with accurate latitude
and longitude.

1. Before adding the benchmarks using Map Projection Settings, check the north and
east coordinates to see if they are in state plane or a local coordinate system de-
termined by the engineer. Typically if the coordinates are large values (millions and
hundred thousands) they are state plane coordinates.

0 ATek Esmpc 4D (641 {ciaaTER e

file Ect View Desslay Uity Oobon: Wingaw Help Gude
TR evort | f e By e e iy [F marview B soview (M wieenmer M siseen [ eenvies

lods REGIEL b AYEO oS A IEBIAE & D

Layer | Data Lines

Surface | Dasign

Lne |  CONTOURS |

By Maorth 1434047 242 East 364056 848 D AB -SNAP Ft INUM -

2. Select the Utility menu and select Transform Job > Map Projection Settings.

T ATEX Earttiwaric A0 {641 - TEG81 Mokl [ M Trak NGl IriclpemIll GPS maoel ] 7 o =
Eée Edit View Display Uty Optios Medow Heio Guide

o = Trangtarm st B Tramlate NoanEsst Trorar T 2

L Alige Matching Fpes L“;ﬂ fobum D Brivn View o

s da Canmaur Suface Stoeteh Sire BOGEEs 8 LYEOmedFBENE & D

Senct 1o Highway Creck Joia Seale -
uty- P -- Wi Prajéciion Setiags 5 I B E A

New Surface

Manage Sirincs

ALl Sy
Diffoet Line

Apaly Temglate
Eloge Gap dhoin)
Swip Enis

Trim Line

Fiset Linw
LengtryAees Infa
Canpiess Seiected
Canvert Tiaysghts
Canfaim Selected
Enter Stk List
Manage Bxport Cofars

= CONTOURS
teh | 1,483.871.381
| 383737204
Mo 14394031883  East 363,220229 Dist: £32 32 TAB SHAP |Fi MJM-
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SmartDirt Geo-Referencing Files

3. Select the desired State Plane Coordinate Zone. Check the proper Unit and click Set.

Map Projection Settings X
Country Units
| United States ] @ us Survey Foot
O International Foot
State Plane Coordinate Zones
O Meters
Alabama East NADS3 v|
EPSG Code | 26729
one Code | 101 Set Cancel

4. Two Benchmarks will be added at the extents of the job with the correct latitude and

longitude. Again, the file must be in state plane coordinates for this utility to work
properly.

W0 AGTER Exrwrk 4D (641 - (it Model ¢

Eile Ect View Deslay gmu'r;_ Gobans_WinoawHelp _(ude

o e [ towey  BF ramiew B sovew [ wimermor M
Jod& Surface |Design

:,: L s Wy I R E Bt View

Layer | Data Lines REREL 0 EYLEomOR AF MEAE & 0

li | CONTOURS
Hoth | 1.493.571.381
Enst 383.737.204

Maorth 1434047 242 East 364056 848

Digt: 57325 TAR SNAR Rt N .

5. The ADF file may now be exported.




SmartDirt Geo-Referencing Files

Save KMZ File

Before we save the ADF file for use with SmartDirt, we recommend exporting a KMZ file
that may be viewed on Google Earth to verify the alignment of the project data is accu-
rate. To export the KMZ file, select the Plan View mode icon on the toolbar.

1. Select File>Export KMZ File. The Save As dialog box displays.

M8 Save As X
Savein: | | dats o] @@ i@
% Name Date modified Type
P No items match your search.
Quick access
Desktop
Libraries
This PC
C 2 :
. M . Flename [Airway SmanDirt Takeoft kmz ~| [ save
etworl
Save as type: KMZ (*.kmz) ~ Cancel
Help
Open KMZ after save KMZ Options
2. Enter a name for the KMZ file and click Save.
3. The KMZ File Export dialog will display.
KMZ File Export ? X
Layers Earthwaork Image Export
[Design A “olume Report (ONaone
[Perimsters Balance Repart (O Current
[ Annotation Ll
[“iPeport Regions Cut Fill Grid
KiZ Resolution
["Balance Regions @ves [JRed/Blue Text O
Low
O Mo
Subgrade
¢ (@) Madium
Sectional Areas
O High
| Previaus Highnray
Ecur[eﬂt_ Mass Diagram |:| Optimize for Mobile
[] Existing
[ Perimsters Upload to Access
res
[JAnnotation Carfarrm KhZ O
@ Mo
[ "Stripped Orves
| Shipping Areas b4 ®ro
£ >

4. Select the desired layers to be saved to the KMZ file. Since we are only viewing this
on Google Earth to verify the alignment, it is recommended to output the plan sheets
and existing data lines. Check Existing under Layers and check All under Image Ex-

port. Click Export.
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SmartDirt Geo-Referencing Files

5. The KMZ file will open in Google Earth. It is recommended you view the KMZ file on
Google Earth to verify the accuracy of the alignment to the job site.

= Gacgle Ea P10
File Edt Yiew Jock Bdd Help

¥ Search

Eont usmctime Hivkry

¥ Places
T S My Pleces
VDS

™ B & Temporary Places
= WS Leway Sranin Takrotf
¥ 4@ Bancherarks
7] 22 Design Annctation
7 d's Design Perimeter
* 3 Report Regions
#I &5 Subgrace Lines
b B3 Sectional Arear
# dlw Existing Lines
7w Exitting Preimieter
A Plan Sheets
& (1) Airway Parkc C-2

E!l | *

¥ Layess
* B i Primary Dutshmce
b 14 P Bordersand Labds
4 B olices
b EE photos
¢/58 Rosds

o
6. The Cut/Fill Map will display by default. To view the plan sheets, check Plan Sheets
on the left under Temporary Places.
= Google Earth Fro =0 EE

B Edt Yew Jock £dd Help

¥ Search

Fent Drmctimss Mivhary

¥ Places
* 4B Banchrurks
¥! 2a Design Annctaticn
4/ Design Penmeter
* B0 Repont Regrons
¢ s Subgrade Lines
* B3 Sedional Aress

e .
7 2w Exitting Perimeters

= 1 ! 17 ALL EXCESS MATERIALTO BE
V&3 (1) Kirway Park C-2 L O CSPREAR ON THWIS SITE U %
¥ &2 (1) Airway Park C-3 T !
v | & cut-Fill

& Subgrade vs, Sripped
b | B3 cut-Fill Grid
Y & agteklogo

Sl =

4 B Blaces
b B 5 photes
¢ 2B foac
£ 10 Buitdings
= Ocean
TF Westher
# Gallery
) Global Avarenase
3 wore
o Temin

7. To verify the alignment is correct, you may change the transparency of the images.
Select Plan Sheets under Temporary Places. Click the blue Zoom button and slide
the bar to the left to see through the images. If the alignment is correct, we are
ready to export the ADF file.
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SmartDirt Geo-Referencing Files

Save ADF File

After the alignment has been verified, we may now export the ADF file for use with

SmartDirt.

1. In Sitework 4D, select the File>Save As. The Save As dialog box displays.

B Save As
Save in | data V‘ @ T @~
i Name - Date modified Ty

No items match your search.
Quick access

Desktop
Libraries
This PC
l <
- File name: Airway SmanDirt Takeoffkmz V‘ [
Network
Save as type! KMZ (" kmz) v

2. Click the Save as Type pulldown and select AGTEK Mobile Files (*.adf).
3. Enter a name for the ADF file and click Save.

4. The ADF Save Options dialog will display.

ADF Save Options ? X

Select surfaces to be saved in file

Reference |Subgrade ~ Difterence | Stripped N

\nc\udelmages Rel and Diff Surfaces Only

[“]Upload to Access

Adrweary Office ~
Airwiary Office Park
Adrway Park Test Site

ject
Alfonso-Pantograph
Ametican Centar
Bill Coggins
Eledsoe FrisonWAWTF
Bridgemill Estates
Canal Quarry
Coast
Calliers Hill Metra District
Country Lane
Crazy horse
Dahlonega Truck
Deed Joy
DevUnifTest

Dutenschmerz v
FUAAM bt

Mew Project Cancel

5. Select the desired Reference and Difference surfaces. Check Ref and Diff Surfaces

Only to limit the size of the file.

6. Select the desired project folder. If no project folder exists, create a new project.

7. Check the boxes to Include Images and Upload to Access. Click OK.

8. The file will be uploaded to the project folder for use with SmartDirt.

2-9



Section 3

Basics






SmartDirt Basics

SmartDirt - Basics

SmartDirt geo-references your plan sheets, cut/fill maps, and takeoff quantities using the
GPS positioning capability built into your IPhone or IPad. Geo-reference the file using the
procedure described in the previous section.

1. Before launching SmartDirt, make sure the GPS feature is enabled on your phone.
This procedure will vary with different phone versions.

2. To launch SmartDirt, locate the SmartDirt icon in your Apps. You may move the icon
to your Home screen if desired.

SmartPlan SmartDirt

3. Enter your Login and Password information. Check the box to Remember password
and select Login.

4. Select any available SmartDirt Key.
If the file has not been saved locally to the phone, select AGTEK Access.

6. Locate the project folder and select the desired ADF file. The file will open and you
will automatically be geo-referenced to the job site. The cut/fill color map will dis-

play.

Q3 TF.u A 42PN

} SmartDirt 3 O
N:1276.88 E:-4857.76 Z:401.43
L: Daylight Line
Afrway SmartDirt

MTEK

——— 300 1, @
» Subgrade: 401.28 ;
Stripped: 401.40 co12¥ b
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SmartDirt Basics

' ‘ Measure

®

} SmartDirt — Menu
N:1110.28 E:-4889.73  2:396.39 Toggle
P: D: 104.50 ft.Y Distance/
Airway SmartDirt Slope
Record
— A Ph
Tracks el Ad Photos
0—— Add Notes

disengage
GPS to

ﬂoooo {}Wooor

Q Tap to
——

A pan data
Reference e 9016 A _ onscreen
and _P Sub?radef 398.21 c1.7 4v S
Difference Sl \ Distance
surfaces = [J < from last
point
. to your
Depth of Cut/Fill current
position
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SmartDirt Basics

SmartDirt - Layer Controls

When using an ADF file, all data saved in the file is stored in separate layers. You may

turn layers on and off by using the layer controls.

1. To change the displayed data, tap the menu and select View.

} SmartDir

N:1065.39 [E:-488¢
P:
Airway SmartDirt

f]%ﬁ

QB THU=079%E2:16 PM

View

Show Plansheets

File

Settings

Save

E Design
Design lines

Annotation lines

Sectional areas

Report regions

E] Existing

—J
—

| TR

Design perimeters

]
[
v

O

N

[ S

Layers

— Visibility

2. All data saved in the file will be listed at the bottom of the screen. Visibility is con-
trolled by a check box. Check or uncheck the box to toggle the display of the layer.
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SmartDirt Basics

|

-}— SmartDir

N:1188.05 E:-478;
P:
Airway SmartDirt

| e

Q 2 T 72% H 2:49 PM

View

Show Plansheets =—

File

Settings

Save

To display the plan sheets, tap the Menu and select Show Plan Sheets Plan Sheets.

Toggle
between
|___Plan Sheets
and Cut/Fill
Map

the sheet and select the desired sheet.

-}- SmartDirt

N:1142.53 E:-4930.77
P:

Airway SmartDirt

Mrr.. +

Q% THE.78%E2:19PM

3 O :

Z:396.17
D: 80.85ft.Y

G

P
PROPBSED
b 2 STORY8UILDING

P
)
e

- % e
» Subgrade: 396.89 c 2.98v ;
Stripped: 399.87 D: 38.7
= [T i

Airway Park

Airway Park C-2_pg1-0

You will now be walking on the plan sheets. If plan sheets overlap, tap and hold on

Q2 FYE.77%E2:21 PM

C-3_pg1-1




SmartDirt Basics

SmartDirt - Measure Mode

Measurements may be made using either the plan sheets or the job data.

1. To enter Measure mode, tap the Tape Measure button.

2. Tap the screen to enter the points. The cut/fill volumes, length and area will be dis-
played at the bottom of the screen. The length is the accumulated length up to the
last entered point. The area is the shaded area. To get the total length of the perim-
eter, you must enter a point back on the starting point. If you make a mistake, tap
the Backspace button.

‘ * SmartDirt

Q@ B Tl 73% W 2:47 PM

< A :
Subgrade - Stripped Z:402.50 Wy
Airway SmartDirt Measure 1
B | i
p a i i
| / *
| [958 @ ¢ & ¢ Sy o
Snap — < |
V 2
Length |
and a e
Area ~
of the L: 240.;: f - C: 222.6 cy
selected A: 21,7204 s F:173.7 cy -\
measure I_'__l' Backsp@e <_
area

New Measure

Cut/Fill
Volume of
the selected
measure area

Tap to toggle
\ through

multiple
measure areas
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SmartDirt Basics

SmartDirt - 3D View

Tap the 3D button to view the 3 dimensional view of the reference surface.

1. Use the pinch to zoom to zoom in and out on the view. Rotation is controlled by the
compass in the phone or tablet.

Q 2 T 72% & 2:50 PM

i
%)
5
&
—~
O
o]

N:1118.6 E:-4811.1
Airway SmartDirt

e ®

» Subgrade: 398.19 c1 72v _
Stripped: 399.91 . D: 73.4

= (3 <

| TR

2. Tap the 3D button again to exit the 3D view.
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SmartDirt Basics

3. To upload all photos, notes, tracks and measure areas tap the menu and select Save.

S Q % FUF. 74%E 2:35PM

} SmartDir View

N:1095.73 E:-482¢ show Plansheets

P:
Airway SmartDirt File
\/ L
f [ Settings i
Save
| g =

® TUF.al 74% @ 2:30 PM

} Save H

Filename

5.3.18_2_30 .kmz

Project:
Airway Office Park v

Save Cancel

5. All user added data will be uploaded to AGTEK Access to be downloaded in the of-
fice.
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SmartDirt Basics

SmartDirt - Download Photos, Tracks, Notes and Measures

If photos, tracks, notes or measure areas were uploaded during the job site session, they
may be downloaded to the office computer using AGTEK Access. AGTEK Access is a
web based application.

1. From your web browser, visit Apps.agtek.com. Enter your login and password. It is
recommended you bookmark this site for future sessions.

2. Open the Projects folder and locate the desired project.
3. Open the desired project folder.

4. Open the User Tracks folder to locate the KMZ file containing the tracks and photos.
The individual photos will also be stored in the Photos folder.

B & [ sppsagrekcom ® |4 v i3 o X
« = O fh e ——— w o L =
Logout

Access Prajects Machines
AGTEK Training Room

[ oownioad
© Projects BEYEEEEBE upioas | [ |

& archived Projects

¥ 1 Airway Name & Typf Description Size % Madified »
Job Files ko
Other = ¥ 0217 2018.14.21 kmz kmz 936 KB 417/2018 2:41 PM
Phatos ® ga_17_2008_14 02kmz kmz 939KB ANTI018 214 PM
feports 5 ® 03 06.2018.15.21 kmz kmz 932 KB 3/6/2018 2:03 PM
Simulations ® 3682 02 ke kmz 92.9 KB 3/6/2018 2:02 M
Surveys o .

3 kmz 92.9KB 3/6/2018 157 PM

3.6_18.1_ 57 kmz

Bridgemill Estates
Eridgemill Phase 1
Fallon Sports Park

Files

5. Select the desired file and click Download.

6. Select the destination folder and click Save. Depending on your browser the file may
automatically download to your Downloads folder.
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i Deskicg W Photosrz
T & stackpie kmz

¥ @ Suncoast 33 Dverakmg
e mame: | 04_17_2018_14_21 ke

Save a type: KME (*kenz)
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SmartDirt Basics

7. The KMZ file may be opened in Google Earth to view the recorded photos,tracks,
notes and measures.

-
= Google Earth
File Edit View Tools Add Help
¥ Search

Get Directions History

¥ Places
[ A Track2 - Earhart-Way.
o Measure 1
1. 969 4:00 PM — C!ear&:ush
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1A Brush
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Qlm N
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4 [@ & primary Database
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[ More
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